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Data visualization with ggplot2 : : CHEAT SHEET

G eo m S Use a geom function to represent data points, use the geom's aesthetic properties to represent variables.
Each function returns a layer.

Basics

is based on the grammar of graphics, the idea 5,
that you can build every graph from the same GRAPHICAL PRIMITIVES TWO VARIABLES L e
components: a data set, a coordinate system, a <- ggplot(economics, aes(date, unemploy)) both continuous continuous bivariate distribution’
and geoms—visual marks that represent data points. b <- ggplot(seals, aes(x = long, y = lat)) e <~ ggplot(mpg, aes(cty, hwy)) h <~ ggplot(diamonds, aes(carat, price))

h + geom_bin2d(binwidth = ¢(0.25,500))

a+geom_blank()and a + expand_limits() ymha-mlor Tl inetype, size
XY, " PR i 1_m‘ a

[nn (a] ® +geom_label(aes(label = cty), nudge_x=1,
> Ensure limits include values across all plots. (B/c) nudge_y =1) - x, y, label, alpha, angle, color,

— .. by "
+ —_— J ® b + geom_curve(aes(yend = lat + 1, family, fontface, hjust, lineheight, size, vjust e IM.MJ“)
¢~ xend=long+1), curvature = 1) -x, xend, y, yend, e + geom_point() %, y, alpha, color, group, linetype,
m=l :;:":":‘m plot alpha, angle, color, curvature, linetype, size X, y,‘alpha, color, fill, shape, size, stroke i : ; L
a + geom_path(lineend = "butt", ' 4 ns '.lom-mcolor“ , size
To display values, map variables in the data to visual 6{ linejoin = "round", linemitre = 1) / e +geom_quantile() x5 "4l x y,alpha, color, fill, siz
pzperﬁes of the geom (aesthetics) like size, color, and x x,y, alpha, color, group, linetype, size 7 x,y,alpha, color, group, linetype, size, weight
and y locations. | ; :
a + geom_polygon(aes(alpha = 50)) - x, y, alpha, = e+ geom_rug(sides="bl") continuous function
’ . color, fill, group, subgroup, linetype, size B x, ¥, alpha, color, linetype, size economics, aes
J— — ¥ , ; o
ju— -+ o e b + geom_rect(aes(xmin = long, ymin = lat, e + geom_smooth(method = Im) a
—— : T ko long + 1, ymax = lat + 1)) - xmax, xmin, ’ x,y, alpha, color, fill, group, linetype, size, weight
plot ymax, ymin, alpha, color, fill, linetype, size
system = . e + geom_text(aes(label = cty), nudge_x =1,
L e el et
alpha, color, fill, group, lin et;r pe, size A Ag family, fontface, hjust, lineheight, size, vjust

LINE SEGMENTS
common aesthetics: x, y, alpha, color, linetype, size one discrete, one continuous
~_  b+geom_abline(aes(intercept =0, slope=1)) f <- ggplot(mpg, aes(class, hW)) J /

i ‘( b + geom_hline(aes(yintercept = lat))

{

ez ‘ b+ geom vline(aes(xintercept = long))

b d=lat+1,xend=long+1
B e

o {im il



StatS An alternative way to build a layer.

A stat builds new variables to plot (e.g., count, prop).

meen
o D
data stat coordinate plot
o, Fotem

Visualize a stat by changing the default stat of a geom
function, geom_bar(stat="count") or by using a stat
function, stat_¢ "bar"), which calls a default
geom to make a layer (equivalent to a geom function).
Use ..name.. syntax to map stat variables to aesthetics.

' ‘*K

genmmapplngs

ll(aes(ﬂll =.level.),

variable created by stat

S C a l e S Override defaults with scales package.

Scales map data values to the visual values of an
aesthetic. To change a mapping, add a new scale.

n <-d + geom_bar(aes(fill = fl))
il

aesthetic kaged
!oad]us( YScale 10 U

n+ ual- _fill_manual(
II values = c("sk!blue 1oya|blue". "blue", "nav'y
L limits = c("d", "e’ , breaks =c("d" "e", "p" “r")

name =" el" laber; c("D" SEYPY "R'))
ge of titletouse n | labels to use | breaks to use in
values lnlnclude legend/axis J Inlegend/axis legend/axis
in mapping

scale-specific
scale to use argumen

GENERAL PURPOSE SCALES
Use with most aesthetics

scale_*_continuous() - Map cont’ values to visual ones.
scale_*_discrete() - Map discrete values to visual ones.

scale_*_binned() - Map continuous values to discrete bins.

mh_ _khm!ty() - Use data values as visual ones.
*_manual(values = () - Map discrete values to
manuall'y chosen visual ones.
*_date(date_labels = "%m,
~ date 'Bruks ="2 weeks") - Treat é:g v)alues as dates.
~ scale_*_datetime() - Treat data values as date times.
Same asme da’te() See ?strptime for label formats.

X & Y LOCATION SCALES

Coordinate Systems

r <-d +geom_bar()
r + coord_cartesian(xlim = c(0, 5)) - xlim, ylim
The default cartesian coordinate system.

r + coord_fixed(ratio = 1/2)
o ratio, xlim, ylim - Cartesian coordinates with
i fixed aspect ratio between x and y units.

ggplot(mpg, aes(y = fl)) + geom_bar()
Flip cartesian coordinates by switching
x and y aesthetic mappings.

‘ r + coord_polar(theta = "x", direction=1)
theta, start, direction - Polar coordinates.

r+coord_trans(y = “sqrt") - x, y, xlim, ylim
Transformed cartesian coordinates. Set xtrans
Tl I and ytrans to the name of a window function.

m + coord_quickmap()
{.;3‘\ nt + coord_map(projection = "ortho", orientation
U =c(41,-74,0)) - projection, xlim, ylim
~7 Map projections from the mapproj package
(mercator (default), azequalarea, lagrange, etc.).

Position Adjustments

Position adjustments determine how to arrange geoms
that would otherwise occupy the same space.

s <~ ggplot(mpg, aes(fl, fill = drv))
s + geom_bar(; ion = "dodge")
Arrange elements side by side.

= nmn)
Stack elemems on top of one
another, normalize height.

Facetingﬁ

Facets divide a plot into
subplots based on the
values of one or more
discrete variables.

t <- ggplot(mpg, aes(cty, hwy)) + geom_point()

]!

t + facet_grid(cols = vars(fl))
mn Facet into columns based on fl.
t + facet_grid(rows = vars(year))
Facet into rows based on year.
" t+facet_grid(rows = vars(year), cols = vars(fl))
Facet into both rows and columns. i
t + facet_wrap(vars(fl))
Wrap facets into a rectangular layout.

Set scales to let axis limits vary across facets.
t + facet_grid(rows = vars(drv), cols = vars(fl),
scales = "free")
x and y axis limits adjust to individual facets:

"free_x" - x axis limits adjust
"free_y" - y axis limits adjust

Set labeller to adjust facet label:
uwmm=mu),uhw-ma
TNe TN T A A CRTE
Hwﬂlm=ml), s
labeller =




Data transformation with dplyr : : cHEAT SHEET

dplyr functions work with pipes and expect tidy data. In tidy data:

nnn nnn s
& M= N
II I = y pipes
Eachvariableisin Each observation, or X %>% f(y)
its own column case,isinitsownrow  becomes f(x, y)

Summarise Cases

Apply summary functions to columns to create a new table of
summary statistics. Summary functions take vectors as input and
return one value (see back).

i summaryfunction -

mEm _, B summarise(.data, ...)
- L Computetableofsummanes
summarise(mtcars, avg = mean(mpg))

‘count(.data, ..., wt=NULL, sort = FALSE, name =
)i ULL) Count number of rows in each group
defined by the variables in ... Also tally().
t(mtcars, cyl)

Manipul

EXTRACT CASES

ate Cases

Row functions return a subset of rows as a new table.

RN EEm
ad [ 1]
mEm

' [T
EEE
1]

N _, mEE
suE > mEn
EEE EEE
BEE
mER

filter(.data, . reserve = FALSE) Extract rows
that meet Ioglca criteria.
filter(mtcars, mpg > 20)

distinct(.data, ..., .keefJ all = FALSE) Remove
rows with duplicate value:
distinct(mtcars, gear)

slice(.data, ..
by position.
slice(mtcars, 10:15)

., .preserve = FALSE) Select rows

slice_sample(.data, ..., n, prop, welﬁht _by=
NULL, replace = FALSE) Randomly select rows.
Use n to select a number of rows and prop to
select a fraction of rows.

slice_sample(mtcars, n =5, replace = TRUE)

slice_min(.data, order_by, ..., n, prop,
with_ties = TRUE) and slice max() Select rows
with the lowest and highest values.
slice_min(mtcars, mpg, prop = 0.25)

slice_head(.data, ..., n, prop) and slice hll()

glelect the ﬁrst or last rows.

Manipulate Variables

EXTRACT VARIABLES

Column functions return a set of columns as a new vector or table.

-k - pull(.data, var=-1, name = NULL, ...) Extract
T B | column values as a vector, by name or index.
EEE =W pull(mtcars, wt)

.-1-, ..= select(.data, ...) Extract columns as a table.
EEE W select(mtcars, mpg, wt) 1
mEE W

Rl RN I"lm( data before NULL, ;

S = Move columns to new position.

BEE EEN
Boo  oom relocate(mtcars, mpg, cyl, aftej.



Vectorized Functions

TO USE WITH MUTATE ()

mutate() and transmute() apply vectorized
functions to columns to create new columns.
Vectorized functions take vectors as input and
return vectors of the same length as output.

=

LT

g vectorized function

OFFSET

dplyr:lag() - offset elements by 1
dplyr:lead() - offset elements by -1

CUMULATIVE AGGREGATE

dplyr:cumall() - cumulative all()

dplyr:-cumany() - cumulative any()
cummax() - cumulative max()

dplyr::cummean() - cumulative mean()
cummin() - cumulative min()
cumprod() - cumulative prod()
cumsum() - cumulative sum()

dplyr::cume_dist() - proportion of all values <=
dplyr-:dense_rank() - rank w ties = min, no gaps
dplyr-:min_rank() - rank with ties = min
“dplyr:ntile() - bins into n bins
lyr-percent_rank() - min_rank scaled to [0,1]
_number() - rank with ties = "first"

Summary Functions

TO USE WITH SUMMARISE ()

summarise() applies summary functions to
columns to create a new table. Summary
functions take vectors as input and return single
values as output.

© summary function 7\ "

COUNT

dplyr:n() - number of values/rows
dplyrn_distinct() - # of uniques
sum(lis.na()) - # of non-NA’s

POSITION
mean() - mean, also mean(!is.na())
median() - median

LOGICAL

mean() - proportion of TRUE’s
sum() - # of TRUE’s

ORDER

dplyr:first() - first value
dplyr-last() - last value
dplyr::nth() - value in nth location of vector

RANK

quantile() - nth quantile
min() - minimum value
max() - maximum value

SPREAD

IQR() - Inter-Quartile Range
() - median absolute deviation

eviation

BRI RRRRRRRRRRRRRRR RN DY)

Combine Tables

COMBINE VARIABLES

X Yi

Alslc) annp [alelclElElo)
2t o s — FRTEEE
blu 2 BWE — bLuzZEEE
v dwin cvi3dwin

bind_cols(..., .name_repair) Returns tables
placed side by side as a single table. Column
lengths must be equal. Columns will NOT be
matched by id (to do that look at Relational Data
below), so be sure to check that both tables are
ordered the way you want before binding.

RELATIONAL DATA

Use a "Mutating Join" to join one table to
columns from another, matching values with the
rows that they correspond to. Each join retains a
different combination of values from the tables.

left_join(x, y, by = NULL, copy = FALSE,
suffix=c("x", "y"), ..., keep = FALSE,
na_matches = "na") Join matching
values from y to x.

no@En right_join(x, y, by = NULL, copy = FALSE,

==%= suffix = c(".x", ".y"{, ..., keep = FALSE,

@wwiy Na_matches="na") Join matching
values from xtoy.

DOBO inner_join(x, y, by = NULL, copy = FALSE,
SLAE suffix=c("x',"y"), .., keep=FALSE,

only rows with matches.

na_matches = "na") Join data. Retain G

..

COMBINE CASES

[alelc}
atl
X B

bind_rows(..., .id = NULL)
Returns tables one on top of the
other as a single table. Set..id to
a column name to add a column
of the original table names (as
pictured).

Use a "Filtering Join" to filter one table against
the rows of another. 2 il

X y s
noR o} .
Al + —

bu2 ® —

@i

noE  semi_join(x, y, by
- ...,na_matcb{s,}
that have a match!




Tidy data is a way to organize tabular datain a gy e
consistent data structure across packages. Re S h d p = D ata -rivotdatato reorganize values into a new layout. EX pa n d
Atable is tidy if: T bl
bhleda
non naE mﬁ 19! I i 2000 | ivot_longer(data, col to=x ¥ GIoA=E
& — A o7k MERE _y | A [l bl M ST Create new combinations of variables or identify
E= B a7k [BOK! Gl values_to ="value", values_drop_na = FALSE) implicit missing values (combinations of
: C 212k 213K G EETT] 212K "Lengthen" data by collapsing several columns variables not present in the data).
Each variableisin Each observation, or ; %% into two. Column names move to a new
its own column case, is in its own row ("B 2000 [P1ES names_to column and values to a new values_to expand(data, ...) Create a
""" column. new tibble with all possible
E A-R-R pivot_longer(tableda, cols = 2:3, names_to ="year", combinations of the values
¥= —— < values_to = "cases") of the variables listed in ...
| - TS Drop other variables.
5 . gL 3 . expand(mtcars, cyl, gear,
Access variables Preserve cases in m%m mmg pivot_wider(data, names_from = "name", o
: : A 1999 0.7K A 1999 07K 00 "
as vectors vectorized operations A 1m.m—-> I —— values_from = "value") 5
ER | B 1908’ [i72M  The inverse of pivot_longer(). "Widen" data by [x1]x2 ]« [x1]1x2]1x3}
Ti b b les A B 37 o handing two columns into several. One column ;‘.“;&"'-P==',E Ilst()) Md mlsdm
© ~ Yol 2R SR
. provides the new column names, the other the :
AN ENHANCED DATA FRAME values.
Tibbles are a table format provided i ;
¥ y pivot_wider(table2, names_from = type,
by the tibble package. They inherit the AT
data frame class, but have improved behaviors: -
. Subset a new tibble with ], a vector with [[and $. TN (0 -
No partial matching when subsetting columns.

conctse views of the data on one screen. S p l |t C e l lS _ Use these functions to split or combine cells into individual, isolated values.

table5
year unite(data, col, ..., sep ="_", remove = TRUE,

99 AT e Tl na.rm = FALSE) Collapse cells across
columns into a single column.

unite(tabl
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Nested Data

A nested data frame stores individual tables as a list-column of data frames within a larger organizing data frame. List-columns can also be lists of vectors or lists of varying data types.
Use a nested data frame to:

« Preserve relationships between observations and subsets of data. Preserve the type of the variables being nested (factors and datetimes aren't coerced to character).

« Manipulate many sub-tables at once with purrr functions like map(), map2(), or pmap() or with dplyr rowwise() grouping.

CREATE NESTED DATA RESHAPE NESTED DATA TRANSFORM NESTED DATA

nest(data, ...) Moves groups of cells into a list-column of a data unnest(data, cols, ..., keep_empty = FALSE) Flatten nested columns A vectorized function takes a vector, transforms each element in

frame. Use alone or with dplyr::;group_by(): back to regular columns. The inverse of nest(). parallel, and returns a vector of the same length. By themselves
n_storms %>% unnest(data) vectorized functions cannot work with lists, such as list-columns.

1. Group the data frame with group_by() and use nest() to move

the groups into a list-column. unnest_longer(data, col, values_to = NULL, indices_to = NULL) dplyr:rowwise(.data, ...) Group data so that each row isone
n_storms <- storms %>% Turn each element of a list-column into a row. group, and within the groups, elements of list-columns appea_f,
group_by(name) %>% directly (accessed with [[ ), not as lists of length one. When
nest() starwars %>% use rowwise(), dplyr functions will seem to apply flmcﬁm
select(name, films) %>% list-columns in a vectorized fashion. )

2. Use nest(new_col = c(x, y)) to specify the columns to group
using dplyr:select() syntax.
n_storms <- storms %>%

unnest_longer(films)

nest(data = c(year:long)) [__name | films ___| I ——
Luke  The Empire Strik... <tibble (S0P bble (5014}
"cell" contents | Revengeof theSS... m"m
FRTECT [rame | fims | | Retumo the Jed. bbieisod DS
[name] yr | st | iong [l name [ yr [ tat ] long | 1975 215 -719.0 [ luke <chr [5]>
Amy 19 790 Amy 1975 27.5 -79.0 1975 285 -79.0 EECEPOEN <chr[6)>
7 ) [Amy 1975 285 -790 nested data frame 1975 295 190 I R2D2 )

thv 1975 295 790 pEOEETTTES  EEIEET
] OIEB601  fan FAmv <tlbble (503> 1979 220 -96.0
2251 Roea) | <tbble 503>

Ei-u [<tibble [50x31>

“Zeta 2005 239
Zeta 2005 242 361 g---
SN N i 1 —— unnest_wider(data, col) Turn each element of a list-column into a

regular column.

Index list-columns with [[]]. n_stormsSdatal[[1]]

starwars %>%

CREATE TIBBLES WITH LIST-COLUMNS select(name, films) 9%>%
7 unnest_wider(films)

name Mms



Data import with the tidyverse

Read Tabular Data with readr

rnd _*(file, col_names = TRUE, col_types = NULL, col_select = NULL, id = NULL, locale, n_max = Inf,
skip=0,na=c("", "NA"),guess max = min(looo n_max), show_col_types = TRUE) See ?read_delim

> “ﬂ- read_delim("file.txt", delim = "|") Read files with any delimiter. If no
R delimiter is specified, it will automatically guess.
4115/INAl  To make filetxt, run: write_file("A|B|C\n1[2|3\n4|5|NA", file = "file.txt")

AB C[H —t “ﬂ- read_csv("file.csv") Read a comma delimited file with period
p 2’3 1 Failim decimal marks.

2, SINA] il e .

pr i write_file("A,B,C\n1,2,3\n4,5,NA", file = "file.csv")
e 3 nﬂ- read_csv2("file2.csv") Read semicolon delimited files with comma
]‘5.'2.3 RiElN decimal marks.
4,5'~sl-NA 455 write_file("A;B;C\n1,5:2;3\n4,5:5;NA", file = "file2.csv")

P > EMIEEEEEE  read_tsv("file.tsv") Read a tab delimited file. Also read_table().

One of the first steps of a project is to import
outside data into R. Data is often stored in
tabular formats, like csv files or spreadsheets.

The front page of this sheet shows
how to import and save text files into
R using readr.

The back page shows how to import
spreadsheet data from Excel files
using readxl or Google Sheets using
googlesheets4.

CHEAT SHEET

OTHER TYPES OF DATA
Try one of the following
packages to import other types of files:

« haven - SPSS, Stata, and SAS files

« DBI-databases

« jsonlite - json

+  xml2- XML

+  httr-Web APIs

+  rvest- HTML (Web Scraping)

+ readr:read_lines() - textdata

Column Specification with readr

Column specifications define what data type each
column of a file will be imported as. By default
readr will generate a column spec when a file is

read_csv("file.csv', n_max =1)

Read values as missing
read_csv("file.csv’

e 1 2 3 read_fwf("file.tsv", fwf_widths(c(2,2, NA))) Read a fixed width file. read and output a summary.
FallTsTINAT  write_file("A\tB\tC\N1\t2\t3\n4\t5\tNA\N', file = "file.tsv") ey
45 NA spec(x) Extract the full column specification for
) the given imported data frame.
USEFUL READ ARGUMENTS spec { xz
cols
m No header ENFAEN  Skip lines # age = col_integer(),
read csv("flle csv', col_names = FALSE) [4|lslNal  read_csv('file.csv’, skip=1) # sex = col_character(),
# earn = col_double() g
Read a subset of lines #)

s a double (numeric




Import Sprea!sheets
with readxl|

READ EXCEL FILES

|_|alB|C|D|E]

Bl xt %2 x3 x4 x5 [ x1 [x2[x3[x4[x5]
B x 28 —>» x NA z 8 NA
ﬂy7 9 10 y 7 NA 9 10

M_-nl(plth. sheet = NULL range NULL)
‘Read a .xls or .xlsx file based on the file extension.
sedront pam for more read arguments. Also

READ SHEETS
[A|B|C|D|E] read_excel(path, sheet =
NULL) Specify which sheet
to read by position or name.
: read_excel(path, sheet = 1)
Els2ss read_excel(path, sheet = "s1")
excel_sheets(path) Get a
s1 s2 s3 vector of sheet names.

excel_sheets("excel_file.xIsx")

To read multiple sheets:

1. Geta vector of sheet
names from the file path.
2. Setthe vector names to

readxl

READXL COLUMN SPECIFICATION

Column specifications define what data type
each column of a file will be imported as.

Use the col_types argument of read_excel() to
set the column specification.

Guess column types

To guess a column type, read_ excel() looks at
the first 1000 rows of data. Increase with the
guess_max argument.

read_excel(path, guess_max = Inf)

Set all columns to same type, e.g. character
read_excel(path, col_types = "text")

Set each column individually
read_excel(
path,
col_types = c("text", "guess’, "guess’,'numeric")

COLUMN TYPES
mm

« date
o list

« skip
* guess

« logical
. numeric

with googlesheets4

READ SHEETS
| |AlBICID]E]

N x1 x2 x3 x4 x5 [ x1x2[x3] x4 [x5|
HFx z8 —>» x NA'z 8 NA
Ely 7/ ‘810 y 7 NA 9 10

s1

| more read argumenu. Same

SHEETS METADATA

URLs are in the form:
https://docs.google.com/spreadsheets/d/
SPREADSHEET_ID/edit#gid=SHEET_ID

gs4_get(ss) Get spreadsheet meta data.
gs4_find(...) Get data on all spreadsheet files.

sheet_properties(ss) Get a tibble of properties
for each worksheet. Also sheet_names().

write_sheet(data, ss=
NULL, sheet = NULL)

Write a data frame into a

GOOGLESHEETS4 COLUMN SPECIFICATION

Column specifications define what data type
each column of a file will be imported as.




Apply functions with purrr

Map Functions

CHEAT SHEET

ONE LIST

map(.x, .f, ..
of a list or vector, return a list.

x <- list(1:10, 11:20, 21:30)

11 <-list(x=c("a", "b"), y=c('c","d"))
map(l1, sort, decreasing = TRUE)

.) Apply a function to each element

TWO LISTS

map2(.x, .y, .f, ...) Apply a function to pairs of
elements from two lists or vectors, return a list.

y <-list(1, 2, 3); w-llsl(1 5,6); 12 <- |I<.l(\» a'y="2")
map2(x,y,~ x"y)

mapt@. fun, ..

fun(M,
) —— fun(M,
fun(mm,..

)
I—b@
)

) m map_dbl(.x, .f,...)

| ing Return a double vector.

L} map_dbl(x, mean)

B ] map_int(.x, .f,...)

BB Return an integer vector.

) B map_int(x, length)

() B map_chr(.x, .f,...)

il b | Return a character vector.

u map_chr(l1, paste, collapse ="")
mp—l‘“'xl :fx 6 ')

g - | Return a logical vector.

B map_lgl(x, is.integer)

map_dfc(.x, .f, ...)
Return a data frame created
by column-binding.

dfc(ll, rep, 3)

g%
-
-
Ao

alnn..

fun(im,M,...)
) —>!mu.l A=
funimm,. )

map2_dbl(.x,.y, .f,...)
Return a double vector.
map2_dbl(y,z,~ x/.y)

map2_int(.x, .y, .f,...)
Return an integer vector.
map2_int(y,z, +°)

map2_chr(.x,.y, .f,...)
Return a character vector.
map2_t chr(ll 12, paste
collapse ="', sep="")

map2_lgl(.x, .y, .f,...)
Return a logical vector.
map2_lgl(12, 11, *%in% ")

map2_dfc(.x, .y, .f,...)
Return a data frame created
by column-binding.
map2_dfc(l1, 2,

~ as.data.frame(c(x, )

MANY LISTS
pmap(.l, .f ..

.) Apply a function to groups of
elements from a list of lists or vectors, return a list.
pmapllist(x,y,2), ~..1 * (.2 +.3))

fun( ..
pmap fun, )—»!un(lllq.)-b
funmmm

i |
-
CEE col

LISTS AND INDEXES

imap(.x, .f, ...) Apply .f to each element and its
index, return a list.
imapl(y, ~ paste0(y, ": ", x))

imap(@. fun, .

fun(m,1,.
) — fun(m; 2.
fun(m; 3. ..

pmap_dbl(.l, .f,...)
Return a double vector.
pmap_dbl(list(y, 2), ~ x /.y)

imap_dbl(.x, .f,
;'et.upm a double
imap_dbl(y,~y)

v

pmap_int(.l, .f,...)
Return an integer vector.
pmap_int(list(y, z), "+")

.-‘4 u -.\» E

pmap_chr(.l, .f,...)
Return a character vector.
pmap_ chr(llst(ll 12), paste,
collapse =", sep="")

pmap_lgl(l, .f,...)
Return a logtcal
pmap_lgl(list(12, 1), %m% )

- [=1a

pmap_dfc(., |,
a data frame creat:
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Work with Lists
Modify List-
keep(.x, .p, ...) pluck(.x, ..., .default=NULL) (M) modify(.x, .f, ...) Apply a
Select elements that pass a Select an element by name or - function to each element. Also CO l umns
logical test. ) index. Also attr_getter() and cH modify2(), and imodify().
Conversely, discard(). chuck(). um) modify(x, ~.+2) List-columns are colu'r‘nns ofa
| i . e
Syl ) GGm) modify_at(.x, .at, .f, ...) Appl =a y_Wﬂﬁ value. Columns can also be lists of
- A al)|—»(am _at(.x, .at, .1, ...) Apply @ 4 <int(d)>
aw)»(b®) compact(x,.p =identity) bm| |om| function to selected elements. 5 l<int] data frames. See tidyr for
bW Drop empty elements. A cl ci|  Also map_at(). about nested data and list
= compact(x) am)->am Zssygn_m()l(, wherel, value) d dMm)  modify_at(x, "b’, ~+2) columns. -
bm| |bm ssign a value to a location i
) cH cH using pluck selection. s WORK WITH LIST-COLUMNS o
- B head_while(x,.p,...) im) = assign_in(x, "b", 5) (Gm) modify_if(.x, .p, .f, ...) Apply a Manipulate list-columns like any other kind
Return head elements until X %>% assign_in("b’, 5) bm function to elements that pass column, using dplyr functions like mutate()
one does not pass. cl a test. Also map_if(). transmute(). Because each elementis a. J
Also tail_while(). um) modify_if(x, is.numeric,~.+2) map functions within a column function tc

head_while(x, is.character) manipulate each element. b

Apply a function to a value at <y |-»(_xvy | modify_depth(.x, .depth, .f, ...)
»@ detect(.x, .f, ..., dir= a selected location. €L L) Apply function to each element
@ c("forward", "backward"), modify_in(x, "b", abs) g at a given level of a list. Also
.right=NULL, .default = NULL) x %>% modify_in("b", abs) map_depth().
Find first element to pass. modify_depth(x, 2, ~.+2)

detect(x, is.character)

modify_in(.x, .where, .f)

c("forward", "backward"),

.. 5 detect_index(x, f,..., dir= REShape Combine

right= Find index of flatten(.x) Remove a level of append(x, values, after =
f’::gt eler’:ngr':lt- {'o l|‘:as|sn = -’ indexes from a list. @"@" length(x)) Add values to end of
detect_index(x, is.character) Also flatten_chr() etc. list.

flatten(x) append(x, list(d =1))

0| array_tree(array, margin =
) NULL) Turn array into list.
BE)  Also array_branch().
array_tree(x, margin = 3)




String manipulation with stringr : : CHEAT SHEET %

The stringr package provides a set of internally consistent tools for working with character strings, i.e. sequences of characters surrounded by quotation marks. Stri n g r

Detect Matches Subset Strings Manage Lengths

| TRUE str_detect(string, pattern, negate = FALSE) | B | str_sub(string, start = 1L, end = -1L) Extract . str_length(string) The width of strings (i.e.
o, Mt Detect the presence of a pattern match in a = -»> = substrings from a character vector. -»> ¢ number of code points, which generally equals
I = string. Also str_like(). str_detect(fruit, "a") H ] str_sub(fruit, 1, 3); str_sub(fruit, -2) 3 the number of characters). str_length(fruit)
= T str_starts(string, pattern, negate = FALSE) | | str_subset(string, pattern, negate = FALSE) 1 str_pad(string, width, side = c("left", "right",

- Detect the presence of a pattern match at — e Return only the strings that contain a pattern >a "both"), pad = ") Pad strings to constant

] ThUE the beginning of a string. Also str_ends(). match. str_subset(fruit, “p") B width. str_pad(fruit, 17)

str_starts(fruit, "a") )
str_extract(string, pattern) Return the first str_trunc(string, width, side = c("right", "left",

str_which(string, pattern, negate = FALSE)
Find the indexes of strings that contain
a pattern match. str_which(fruit, “a")

str_locate(string, pattern) Locate the
positions of pattern matches in a string.

=- - o
v
=gz =

pattern match found in each string, as a vector.

Also str_extract_all() to return every pattern
match. str_extract(fruit, "[aeiou]")

str_match(string, pattern) Return the
first pattern match found in each string, as

"center"), ellipsis =". ") Truncate
of strings, replacing Content with ell
str_trunc(sentences, 6) -

str_trim(string, side = c("
Trim whitespace from the

o s Also str_locate_all(). str_locate(fruit, "a") a matrix with a column for each () group in a string. str_trim(str_p:
pattern. Also str_match_all().

== o str_count(string, pattern) Count the number str_match(sentences, "(althe) ([* +])*)

?.': - : of matches in a string. str_count(fruit, “a")

[ 1) 2

Mutate Strings Join and Split

" n str_sub() <- value. Replace substnnis str_c(...,sep="", collapse = NULL) Join
= > s ldentlfymg the substnngs with str_sub() and multnrle strings into a single string.
# : into the results. str_c(letters, LETTERS)

str sub(fEu:t 1,3) <-"str"
str_flatten(string, collapse ="") Combines

F '@dr uphce(stnng, pattern, replacement) into a single strl_n% separated by collapse
hed pattern in each str_flatten(fruit,

str_dup(string, times) R
times. Also str_unique



&

Need to KnOW Regular ExpreSSIOnS L Regnlpl‘exprossions,ormgcxps,areaconciselanguage for [:space:]

describing patterns in strings. |
: = +! newline

Pattern arguments in stringr are interpreted as < i i " "
regular expressions after any special choracters MATCH CHARACTERS see <- function(rx) str_view_all("abc ABC 123\t.I2\\(){}\n", rx) tblank] I -
have been parsed. string regexp matches example o ; B
(type this)  (to mean this) (which matches this)
In R, you write regular expressions as strings, a (etc.) a (etc.) see("a") abc ABC 123 .17\(){}
sequences of charactﬁrs surrounded by quotes \\ W ! see("\\") abc ABC 123 .I2\()(}
("") or single quotes("').
\\! \! ! see("\\!") abc ABC 123 I17\(){}
Some characters cannot be represented directly \\2 \? ? see("\\?") abc ABC 123 .12\(){}
in an R string . These must be represented as \\W\ \\ \ see("\\\\") abc ABC 123 .12\(){}
special characters, sequences of characters that \\( \( ( see("\\(") bc ABC 123 .I2\(){}
have a specific meaning., e.g. W \ ) see("\)") :bi ABC 123 'i?\()(}
Special Character  Represents \\{ \ { see("\\{") abc ABC 123 ”\0[}
\ \ \\} \} } see( "\\]") abc ABC 123 .1?\(){} -
% X \\n \n new line (return) see("\\n") abc ABC 123 .I2\()(} [:alnum:]
\n new line \\t \t tab see("\\t") abc ABC 123 .12\(){}
Run 2""" to see a complete list t\s :: any whitespace (\S for non-whitespaces) see("\\s") abcABC 123 .1\(){} [:digit:] <
\d any digit (\D for non-digits) see("\\d") abc ABC 123 .172\(){} 1 ]
Because of this, whenever a \ appears in a regular \\w \w any word character (\W for non-word chars) see("\\w") abc ABC 123 .!2\(){} E ﬂ ! n llll
:P{ESS'OD. Youtr'!:ust wrllte itas\\in the string \\b \b word boundaries see("\\b") 'abc ABC '1}5 A0
at represents the regular expression. [:digit:] : digits see("[:digit:]") abc ABC 123 .12\(){}
Use writeLines() to see how R views your string [:alpha:] 1 letters seetilalphaly) EPCABC 123 .10}
after all special characters have been parsed. [:lower:] lowercase letters see("[:lower:]") abc ABC 123 .17\(){}
=i [:upper:] ' uppercase letters see("[:upper:]")  abc ABC 123 .17\(){}
;v‘ntel nes("|\.") [:alnum:] ' letters and numbers see("[:alnum:]")  abcABC 123 .12\(){}
i :[;wmt’él' ' punctuation see("[:punct:]")  abcABC 123 .
writeLines("\| is a backslash") [:graph:] ' letters, numbers, and punctuation see("[:graph:]")  abcABC 123 .l
#\is abackslash [:space:] space characters (i.e. \s) see("[space:]’)  abcABC123 IO} |
e [:blank:] ' space and tab (but not new line) see("[:blank:]")  abcABC123 .2\(0}
(5] every character except a new line see("") 2 2 St

A0
1 Many base R functions require classes to be wrapped in a second set of [ ], e.g.. ?’ﬁ‘




Dates and times with lubridate : : cHEAT SHEET

v

Iubfidéte

Date tlmes 2017-11-28 12:00:00 2017-11-28 12:00:00 Round Date-t'mes
A date-time is a point on the timeline, A date is a day stored as An hms is a time stored as floor_date(x, unit = "second”)
stored as the number of seconds since the number of days since the number of seconds since |‘I Round down to nearest unit.
=t + s ar > 1970-01-01 00:00:00 UTC 1970-01-01 00:00:00 | ! | 1 . floor_date(dt, unit= month”)
Jan Feb Mar Apr st
2017-11-28 12:00:00 dt <- as_datetime(1511870400) d <- as_date(17498) t <- hms::as_hms(85) ;m::-mw:n:tw frit
##"2017-11-28 12:00:00 UTC" ##"2017-11-28" ##00:01:25 " 3
l‘l —>| round_date(dt, unit = "month")
! ! ! Lo
............................................................................................................................................... Jan Feh Mar Apr ceiling_date(x, unit = "second”,
PARSE DATE-TIMES (Convert strings or numbers to date-times) GET AND SET COMPONENTS ety oy change_on_boundary =N
d #42017-11-28 I_,I Round up to nearest unit.
1. Identify the order of the year (y), month (m), day (d), hour (h), Use an accessor function to get a component.  day(d) ## 25 i | | | ceiling date(dt, unit= Z'ﬁ;)
minute (m) and second (s) elements in your data. Assign into an accessor function to change a day(d) < 1 Jan Feb Mar Apr
2. Use the function below whose name replicates the order. Each component in place. d ##"2017-11-01" Valid units are second, minute, hour, day, week, month, bimo

accepts a tz argument to set the time zone, e.g. ymd(x, tz="UTC"). quarter, season, halfyear and year.

L PEYCECFRER] 11:59:59 t. date(dt rollback(dates, roll_to_first = FALSE, preserve_hms
201711 25 T14:02:00 Y hmsl) ymd bl ymd_h( g date(x) Date component. date(d) 20 B0t Prewious month. Also roliforward):

year(x) Year. year(dt)

- .00: ydm_hms(), ydm_hm(), ydm_h(). FLEE]-01-31 11:59:59  isoyear(x) The ISO 8601 year. i :
Soiiaes 2R DoiooRYIm el ydm_ ), Yo el Stamp Date-times

stamp() Derive a template from an

0p:03  mdy_hms(), mdy_hm(), mdy_h(). 2018-[F1-31 11:59:59  month(x, label, abbr) Month : L
11/2%/2017 1:02:03 . 02:03" 228 d d ) function that will apply the tem| |
/2%/2017 °  mdy_hms("11/28/2017 1:02:03") month(dt) it illop % plau
e dmy_hms(), dmy_hm(), dmy_h(). d Derive te, ¢
017.23:59:59 4 ot lay(x) Day of month. day(dt) 1. a ﬁevpphte
1 Jawn 2017 2 dmy_hms("1 Jan 2017 23:59:59") 2018-01- 11:59:59 wday(x, label, abbr) Day of week. sf < stamp("Crea
20170131 ymd(), ydm(). ymd(20170131) qday(x) Day of quarter.
= mdy(), myd(). mdy("July 4th, 2000") 2018-01-31 [§1:59:59  hour(x) Hour. hour(dt)
‘dmy(), dym(). dmy("4th of July '99) 2018-01-31 11:[J:59  minute(x) Minutes. minute(dt)

yq() Q for quarter. yq(*2001: 03") 2018-01-31 11:59:F]  second(x) Seconds. second(dt)
2018-01-31 11:59:59 '




AR RRRRRRRRRERRERRRINT)

M ath W |th Date*t' MES — Lubridate provides three classes of timespans to facilitate math with dates and date-times.

Math with date-times relies on the timeline, Periods track changes in clock times, Durations track the passage of Intervals represent specific intervals Not all years %
which behaves inconsistently. Consider how which ignore time line irregularities. physical time, which deviates from of the timeline, bounded by start and are 365 days I u b ri d a te
the timeline behaves during: clock time when irregularities occur. end date-times. due to leap days.
Anormal day nor + minutes(90) nor + dminutes(90) interval(nor, nor + minutes(90)) Not all minutes
nor < ymd_hms(*2018-01-01 01:30:00"z="US/Eastern’) . are 60 seconds due to
leap seconds.
1:'00 1:'00 !}!D 4:'007 1:30 1:'00 ):‘70 4::70' 1:00 2:00 3:00 4:00 1:00 2:00 3:00 4:00 lt:;sazgf:'gb’l::::hr:'a;?;?l?::’g:‘; gylgm
The start of daylight savings (spring forward) gap + minutes(90) gap + dminutes(90) interval(gap, gap + minutes(90)) jan31 <-ymd(20180131)
gap <-ymd_hms("2018-03-11 01:30:00"tz="US/Eastern") - — jan31 + months(1)
## NA
1:00 2:00 3:00 " > . y . - s 3 g s ! and % will roll i
4:00 1:00 2:00 3:00 4:00 1:00 2:00 3:00 4:00 1:00 2:00 3:00 4:00 dates to the last da y of the Pm -
The end of daylight savings (fall back) ; ; : : month.
2 4 SR - lap + minutes(90) lap + dminutes(90) interval(lap, lap + minutes(90))
lap <-ymd_hms(*2018-11-04 00:30:00"tz="US/Eastern®) jan31 %m+% months(l)
T e 14  —— It ## "2018-02-28"
e i."'-‘ | add_ i el
12:00 1:00 2:00 3:00 12:00 1:00 2:00 3:00 12:00 1:00 2:00 3:00 12:00 1:00 2:00 3:00 il
leap + years(1) leap + dyears(1) interval(leap, leap + years(1)) first day of the new month

Leap years and leap seconds
leap <-ymd(*2019-03-017) i ;ﬁy

add_with_rollback(jan3
roll_to_first=TRUE)

PERIODS DURATIONS INTERVALS
Add or subtract periods to model events that happen at specific clock Add or subtract durations to model physical processes, like battery life. Divide an interval by a durationto
times, like the NYSE opening bell. Durations are stored as seconds, the only time unit with a consistent length.  an interval by a period to determine its |

Difftimes are a class of durations found in base R.

Make a period with the name of a time unit pluralized, e.g. Make a duration with the name of a period prefixed with ad, e.g. Make an interval

< months(3) + days(12) years(x = 1) x years. dd <- ddays(14) dyears(x = 1) 31536000x seconds. i <interval(ymd("
months(x) x months. dd . dmonths(x = 1) 2629800x seconds. j<-d%-
OH OM 0S" weeks(x= 1) x weeks. 1209600s (~2 weeks) dweeks(x = 1) 604800x seconds. '
days(x = 1) x days. m Equivalent ddays(x = 1) 86400x seconds.
hoyu(x= 1) x hours. in common dhours(x = 1) 3600x seconds.
units

“minutes(x = 1) x minutes.
Pcad e



rmarkdown

What is rmarkdown?

7] ‘} .Rmd files - Develop your code and
ideas side-by-side in a single
A\ : document. Run code as individual

chunks or as an entire document.

Dynamic Documents - Knit together
plots, tables, and results with
narrative text. Render to a variety of
formats like HTML, PDF, MS Word, or
MS Powerpoint.

Reproducible Research - Upload, link
to, or attach your report to share.
Anyone can read or run your code to
reproduce your work.

Workflow

Q Open a new .Rmd file in the RStudio IDE by
going to File > New File > R Markdown.

Embed code in chunks. Run code by line, by
chunk, or all at once.

Write text and add tables, figures, images, and
citations. Format with Markdown syntax or the
RStudio Visual Markdown Editor.

o Set output format(s) and optionsin the YAML
header. Customize th oradd p
to execute or add interactivity with Shiny.

Save and render the whole document. Knit
periodically to preview your work as you write.

—

&
-8
v Slo)

CHEAT SHEET

RENDERED OUTPUT ~file path to oulpul document : e e
SOURCE EDITOR . i e, 3 5 h
m oo 10 o e L e = - | Write wit
o s 5. Save and Render et @ 4 find in document
: publishto Markdown
s ey, Document Title [ _
'\ AN 2 P O IsE s e shinyapps.io, The syntax on the left renders as the output on the right.
T set insert  goio run code "M T Author Name i 7
2 title: ~Document T(tle® 3 ot - RStudio Connect Plain text. Plain text.
3 outhor: “Author Nome: preview code  code chunk(s) . TR Mackdown il j
A utpity ocation chunk chunk show End a line with two spaces to End a line with two
% B hiwt - docuwent outline * Including Plots start a new paragraph. start a new
SR 4. Set Output Format(s) i | Alsoend with a backslash\ Also end with a backslash
d and Options R Markdown reload document 1o make a new line. to make a new line.
9+ “*'(r setup, inc 0 . *italics® and **bold**
10 Hl!lr' topts_chunkiset(echo - TRUE) N This is an R is a simple =ty
13 2 | syntax for authoring HTML, PDF, and MS Word documents. For more S“Wf‘“"f‘ 2 { subscript-2~
S : 2 details on using R see hilp//r rstudio.com,
Bl 3. Write Text sl e 9 P s, e \-v“
15 This ( R Markdown document . pf@VlD\lS .
T3 PP -:q;\. ls_tt?ﬂg modify chunks 2 Jlisussary(cace) | endash: --, emdash: -——
17 syntox for outhoring HTML, POF, chunk run - —
18 and MS Word documents. options : crrre‘r(\l - e o # Header 1
19 i Flchunl
20- " {r cors} Dy ## Min. 1 4.0 Min. : 2.00 W4 Header2
21 summary(cars) 2. Embed Code ## 1ot Qu.112.0  lst Qu.: 26.00 -
i 2 #¢ Median :15.0 Median 1 36.00 HE#HHH Header 6
1821 0 R Markdown = R Markdown, 3 ## Mean :15.4 Mean 1 42.98
st Vol T & Markdees & Dok -0 ## 3rd Qu.:119.0  3rd Qu.: 56.00 WI&
B e T |0 rex im0 mexTinizeee "item 22 ind tuzb*

Output created: report.html

VISUAL EDITOR e options

Insert Citations

insert citations
S report.Amd

5} DT Qe - = ‘a-
Normal - B 1 U o T = )= 0 &OEVMo

R Markdown

This is an R Is a simple
syntax for authoring HTML, PDF, and MS Word documents |

.~\-0lul| e i
Insert = Table -

-, add/edit

| Mandown
Inchusng Pros

attributes

Create citations from a bibliography file, a Zotero llbuty
or from DOI references. i

BUILD YOUR BIBLIOGRAPHY
. Add BibTeX or CSL bibliographies to the Y/
htle: "My Document"

bibliography: reference
11nk-c§tag1hy

-item 2b ) ;




. - . o
Set Output Formats and their Options in YAML . £z Render
o
Use the document's YAML header to set an output IMPORTANT OPTIONS  DESCRIPTION 5822 When you render a
format and customize it with output options. anchor_sections Show section anchors on mouse hover (TRUE or FALSE) X document, rmarkdown:
;.*_i;le e o citation_package The LaTeX package to process citations ("default”, "natbib", "biblatex") X 1. Runs the code and embeds
3 ocument"
author: “Xuthor Name" code_download Give readers an option to download the .Rmd source code (TRUE or FALSE) X ;ﬁ:'&ﬁha:gi:?n intoan.md
output: de_foldi " "o Wt " 3 :
html_document: (TaaentTormata che actors code_folding Let readers to toggle the display of R code ("none", "hide", or "show") X 2. Converts the .md file into the output format with
toc: TRUE indent options 4 CRBTRCtalE css CSS or SCSS file to use to style document (e.g. "style.css") X Pandoc.
TR dev Graphics device to use for figure cjlutput(e"g" "png: :pdf") =) ) XEX o) e [ M e
OUTPUT FORMAT CREATES df_print Method for printing data frames ("default", "kable", "tibble", "paged") X X X X
html_document html ﬁg__c?p(ion Should figures be rendered with captions (TRUE or FALSE) XX XX Save, then Knit to preview the document output.
pdf_document* .pdf highlight Syntax highlighting ("tango", "pygments", "kate", "zenburn", "textmate") X X The resultmg HTML/PDF/MS Word/etc. document will
word_document Microsoft Word (.docx) includes File of content to place in doc ("in_header", "before_body", "after_body") XEX, :)heeche;tg?“aend saved in the same directory as
:d(":':fpo'"u:ese"fﬂtmﬂ :;Icrols)oft Powe:;-:romt (.pptx) keep_md Keep the Markdown .md file generated by knitting (TRUE or FALSE) X X X X M ' - ; 1o /knltfnt‘h!R ,
_documen penDocument Text se rmarkdown::render() to render ol
B A keep_tex Keep the intermediate TEX file used to convert to PDF (TRUE or FALSE) X console. See 2render for available options. iR
il Ldocument Moo, latex_engine LaTeX engine for producing PDF output ("pdflatex", "xelatex", or "lualatex") X
github_document Markdown for Github reference_docx/_doc  docx/pptx file containing styles to copy in the output (e.g. "file.docx", "file.pptx") X X S h are
:;:iydes :;:f:;:it::on ::iscl;d:fr :{Mt :lldES theme Theme options (see Bootswatch and Custom Themes below) X Publish on RStudio Connect
= _P! Tl y : slides toc Add a table of contents at start of document (TRUE or FALSE) X X to share R Markdown documents i
‘ me.r_presentatlon. Beamer s.lldes toc_depth The lowest level of headings to add to table of contents (e.g. 2, 3) X X securely, schedule automatic
Al::q:eres u:ﬁxsrﬁ:g:ﬁt‘;::ﬂ’::& Etogaome toc_float Float the table of contents to the left of the main document content (TRUE or FALSE) X
e ’ Use ?<output format> to see all of a format's options, e.g. Zhtml_document
More Header Options
PARAMETERS BOOTSWATCH THEMES STYLING WITH CSS AND SCSS
Parameterize your documents to reuse with new Customize HTML documents with Bootswatch Add CSS and SCSS to your document by adding a
inputs (e.g., data, values, etc.). themes from the bslib package using the theme path to a file with the css option in the YAML header.
1. Add — output option.
- ﬂneMaderas e howaii® Use bslib::bootswatch_themes() to list available title: "My Document"
-— themes. author: "Author Name"

i output:
title: "Document Title" html_document:
author: "Author Name"




Shiny : : CHEAT SHEET

Building an App

A Shiny app is a web page (ui)
connected to a computer
running a live R session (server).

Users can manipulate the Ul,
which will cause the server to
update the Ul’s displays (by

InuinestR
functions to

build an HTML
interface

Tell the server

running R code). how to render
outputs and
respond to
Save your template as app.R. inputs with R
Keep your app in a directory

along with optional extra files.

®9® app-name

app.R
DESCRIPTION

The directory name is the app name
(optional) used in showcase mode

To generate the template, type shinyapp and press Tab in the RStudio IDE
or go to File > New Project > New Directory > Shiny Web Application

Inputs

Collect values from the user.

# app.R

Library(shi
poraryishing) Customize the Ul with Layout Functions

Lui <~ fluidPage P ~
T S O e s ¢ I e Add INputs with *Input() functions

"Sample size", value = 25),

plotOutput (outputId = "hist") Add Outputs with *Output() functions
)

| server <~ function(input, output, session) {
output$hist <- renderPlot({

P Wrap code in render*() functions
his(rnorm(inputsn))

before saving to output

1
Refer to Ul inputs with input$<id>
and outputs with output$<id>

shinyApp(ui = ui, server = se{ver)

Semple size Access the current value of an input object with
1000 input$<inputid>. Input values are reactive.
Histogram of rmorm(inputsn) Action actionlutton(inputld, label, icon,
g width, ...)
8 Link actionLink(inputld, label, icon, ...)

Aol @ Choce 1 heckbox inputid
: @ Choice 2 label, choices, selected, inli
" Choice 3 choiceNames, choiceValu

@ Check me cl oxInput!

CKD
width)

datelnput(inputid, |

mmly. mu’g’,?,’;‘,‘:’,’m f:fa LRt e Sourced See annotated examples of Shiny apps by running |
(optional) directory of files to share with web browsers (images, runExample(<example name>). Run runExample()
[~ CSS, .js, etc.), must be named "www" with no arguments for a list of example names.

) : i
max, format, s
Call shinyApp() to combine ui and server into an interactive app! | : langua
iR |

DT:renderDataTable(expr, options,
searchDelay, callback, escape, env, quoted,




T TI IR RN ]

Reactivity

Reactive values work together with reactive functions. Call a reactive value from within the arguments of one
of these functions to avoid the error Operation not allowed without an active reactive context.

Perform Schedule updates
side effects invalidateLater()
observeEvent() observe(code) Create reactive
pbasve) expressions
reactive() Remove reactivity
isolate()
input$x reactive(code) sy’ 4w output$y
Create your own \
W;“Im renc':mdﬂlp t
reactiveValues() outpu
reactiveFileReader() R‘:::s:ns:d render”()
reactivePoll() evenlReactive()
“Input()
CREATE YOUR OWN REACTIVE VALUES RENDER REACTIVE OUTPUT
B *Input() functions e T) render*() functions
i pn idP, 'Z (see front page) ui <~ fluidpPage( (see front page)
ui < fluidPage ) S e
textInput("a®,","a") | Eachinput function creates | fextaneet{iaiat™ ") Build S
) a reactive value stored as ) UIOSan,00] ECELO/S.
input$<inputid> display. Will rerun code in
. LIRS S e e body to rebuild the object
#reactiveValues example " e 1| whenever a reactive value
server < reactiveValues( ) renderText ({ in the code changes.
function(input,output){ | Creates a list of reactive joeitts
O ompeactiveValuesO) | 5(yes whose values you ) ‘S,Z‘t'e :tgiﬁzl:ﬁ:?&
} canset shinyApp(ui, server) P )
CREATE REACTWE EXPRESSIONS PERFORM SIDE EFFECTS
reactive(x, env, quoted, Ubrary(shing) ol;;e;xgg;:(m:ltgpn
: A
i (2B uany, | eventquoted, handlereny,
actionButton("go®,"Go") handler.quoted. . label,
) suspend domal

U I -An app’s Ul is an HTML document.
Use Shiny’s functions to assemble this HTML with R.

“Layouts

fluidPage(

textInput("a","") Returns
) HTML
#¥ <div class="container-fluid">

#4  <div class="form-group shiny-input-container">

" <label for="a"></label>

" <input id="a" type="text"

" class="form-control" value=""/>
" </div>

#H </div>

MTML Add static HTML elements with tags, a list
of functions that parallel common HTML
tags, e.g. tags$a().Unnamed arguments
will be passed into the tag; named
arguments will become tag attributes.

Run names(tags) for a complete list.
tags$hl("Header") -> <hl>Header</h1>

The most common tags have wrapper functions. You
do not need to prefix their names with tags$

ui <~ fluidPage(
h1("Header 1"), Header 1
hr(),
br(),
p(strong("bold")), bold
p(em("italic")), s
p(code("code")),
a(href="", "link"), code
HTML("<p>Raw html</p>") k.

) Raw him!
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Combine multiple elements
into a "single element" that
has its own properties with a
panel function, e.g.

wellPanel(
dateInput("a”, ""),
submitButton()
N 4 o
absolutePanel()  navlistPanel()
2015.08-10

Organize panels and elements into a a
layout function. Add elements as :

sidebarLayout()



RStudio IDE :

Documents and Apps

. CHEAT SHEET

Source Editor

@studio

Tab Panes Version

Open Shiny, R Markdown, Navigate Openinnew Save Findand Compileas Run Importdata History of past Manage View R tqtorials CO nt ro l
IMTEX | knitr, Sweave, LaTeX, .Rd files  backwards/ wlndow 23 rcplace uolebook selected withwizard  commandsto  external memory 2
- and more in Source Pane forwarcl; £ ~‘code p run/copy _databases usage - == TurnonatTools > Project Options > Git/SVN
Check Render Choose Configure Insert QL% T X ITE X i - '\ ; ¥ aep - (U] = Sgaelgd = g:r?aﬂrlnegd # Untracked 3
spellmg output output render code  Publish & reporthiid « . dappR - O scripy Environmet  Mistory  Connections Suid ‘G Tutonal 1
Iormat options chunk to server T sourceonsav | 4 e 2 b, import Dataset = Y 148 Mis - st 5 .
N 5 ¢ ! Push/P
e : i : 0y LAl : K - | kK Gioqment - 2 ﬁlag.e Sto mer:ﬂ“}des !: ?er('\otzg
2 Re-run Source Withor Showfile Y i les:  stag r
16 . previous code  w/out Echo or outline Load Save Clear R Search inside - :
2 L __ ; 25 a Local Job workspace i workspace workspace environment owi J
« Jumpto Jump  Run  Showfile Visual § (o =Multiple cursors/column selection Choose environment to display from Display objects e
+ previous tonext code  outline Editor ; :mo; with Alt + mouse drag list of parent environments as list or grid ;08 wpt
7 chunk  chunk e g - ' i ‘
J (sris\;) = e Code diagnostics that appear in the margin. ::', P S = Show file diff to view file differences
» Run this and I . I|ovcr over diagnostic symbols for details. Volves TOww ey by < < Mo S e ©
2 Il previous  Run this ont ichlighti x 1
2 Jumpto a.Lp 13 (et (u Am), ___'_“,_‘,Symax highlighting based
W section code chunks code chunk e i;))v‘ 10 A (n - 135" on your file's extension "';‘:"" TR P o)
b m(or SIS Set knitr 1 .. Tab completion to finish function Displays saved objects by Viewin'data View function
1 chunk s 8 fo “names, file paths, arguments, and more.  type with short description viewer source code
‘." options 19 . |/ i ey [l
11 deplemt) 8 batdomn ¢ 2 1 J files  Plots =0
Access markdown guide at 32 L force  (bose) “.Multi-language code snippets to . @
Help > Markdown Quick Reference 2 quickly use common blocks of code. s More file . ® L‘r;
u e tions
See reverse side for more on Visual Editor 25 Jump to function in file Change file type A e et A Changed
1 roptewns asiom:  folder § file file i directory
RStudio recognizes that files named app.R, e e Bl n e e o o i § O e ot e $
server.R, ui.R, and global.R belong to a shiny app . R @8 Path to displayed directory |
0 o v - R -, - (19 appk 10, 2021, 6:21 PM
i).;.,‘ o is .-e E‘; 3 o iWorking Run scripts in Maxim_ize. | A appRpro) 3038 Jul 10, 2021, 4:51 PM l
h;lana‘ége > “ D) sepafaiesess OnS RIS PORER A Fllabrowser keyed to your working directory.
7 F Y " Click on file or directory name to open. p
app locationto shinyapps.io publish it g"/crﬂgt;? g:?%’tg"wn gg.:gnggrr‘i; ---------- y - i
viewapp orserver  accounts| § »| oe€ Yy 3
app o ot E 2z T




Keyboard Shortcuts

RUN CODE Windows/Linux Mac DOCUMENTS AND APPS
Search command history Ctrl+ Cmd+p Knit Document (knitr) Ctrl+Shift+K Cmd+Shift+K
Interrupt current command Esc Esc Insert chunk (Sweave & Knitr)  Ctrl+Alt+| Cmd+Option+|
Clear console Ctrl+L Ctrl+L Run from start to current line  Ctrl+Alt+B Cmd+Option+B
NAVIGATE CODE MORE KEYBOARD SHORTCUTS
Go to File/Function Ctrl+. Ctrl+. Keyboard Shortcuts Help Alt+Shift+K Option+Shift+K
WRITE CODE Show Command Palette Ctrl+Shift+P Cmd+Shift+P
Attempt completion Tabor Tab or
Ctrl+Space Ctrl+Space Viefw the Keyboard Shortcut Quick Search for keyboard shortcuts with
e 2 . : & Reference with Tools > Keyboard Tools > Show Command Palette
Insert < (assngnment operator) Alt+ 5 Option+ 3 Shortcuts or Alt/Option + Shift + K or Ctrl/Cmd + Shift + P,
Insert %>% (pipe operator) Ctrl+Shift+M Cmd+Shift+M
(Un)Comment selection Ctrl+Shift+C Cmd+Shift+C [ ]
MAKE PACKAGES Windows/Linux Mac ey Sl ComenmComt
Load All (devtools) Ctrl+Shift+L Cmd+Shift+L Create a New R Script [cert] [snive | [u]
Test Package (Desktop) Ctri+Shift+T Cmd+Shift+T Create & new & Markdown document
Document Package Ctrl+Shift+D Cmd+Shift+D
V'SU a l Ed ItO r Choose Choose Insert Jumpto Jump  Run .
Check Render output output code previous tonext selected Publish Show file
spelling output  format location chunk chunk  chunk lines to server outline .
: & s o : : H Back to
© | report.Rmd - 2 j,f’ T, | i : /E 0 | .. Source Editor
B a2 QT e - & @ AR - & _-l [iigay] (onteee)

\wz~||1u¢|tl

o
Lists and

3 99!0 .Iﬂlromm-llnun-lhbk-
> 5 3 :

Unks Citabons lmages

Ay
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it blocks,
citations,

equations,and
pecial

|numm
P e

g ~Insertand -
o :

RStudio
Workbench

WHY RSTUDIO WORKBENCH?

Extend the open source server with a

commercial license, support, and more:

« open and run multiple R sessions at once

« tune your resources to improve performance

« administrative tools for managing user sessions
« collaborate real-time with others in shared projects
« switch easily from one version of R to a different ver:
« integrate with your authentication, authorization,

Download a free 45 day evaluation at
www.rstudio.com

Share PrOJects

File > New Project
RStudio saves the call history,
workspace, and working
directory associated with a
project. It reloads each when

proaucts/workben




REST APIs with plumber: : cHEAT SHEET

Introduction to REST APIs

Web APIs use HTTP to communicate between client and server.

HE— . =—gi

server

client

HTTP is built around a request and a response. A client makes a
' request to a server, which handles the request and provides a
onse. Requests and responses are specially formatted text
containing details and data about the exchange between clientand
o |

i‘http //httpbxn org/get” :
~ get HTTP/1.1
S

r 1 ~ b Sr o 25 7
.Headers\z‘ st: )rir, 17 1‘,”

| HTTP Method
il ,

Reguest Body

Message body

HTTP Version } Status code —

Reason phrase

#< HTTF/1.1 200 OK
< Connection: keep-alive
Headers < pate: Thu, 02 Aug 2018 18:22:22 GMT
#

# Response Bod
2 ) Message body

Plumber pipeline

Plumber endpoints contain R code that is executed in response to an
HTTP request. Incoming requests pass through a set of mechanisms
before a response is returned to the client.

Filters can forward requests (after potentially mutating them), throw

errors, or return a response without forwarding the request. Filters
are defined similarly to endpoints using the @filter [name]
tag. By default, filters apply to all endpoints. Endpoints can opt out
of filters using the @preempt tag.

PARSER

Parsers determine how Plumber parses the incoming request body.
By default Plumber parses the request body as JavaScript Object
Notation (JSON). Other parsers, including custom parsers, are
identified using the @parser [parser name] tag. All

Endpoints define the R code that is executed in response to
incoming requests. These endpoints correspond to HTTP methods
and respond to incoming requests that match the defined method.
METHODS
* @get - request a resource
« @post - send data in body
» @put - store / update data
« @delete - delete resource

SERIALIZER

Serializers determine how Plumber returns results to the client. By
default Plumber serializes the R object returned into JavaScript

Object Notation (JSON). Other serializers, includlng custom
serializers, are identified using the @seri
[serializer name] tag. Al registered erializer: s

* @head - no request body

* @options - describe options
« @patch - partial changes

* @use - use all methods

registered parsers can be viewed with registered parsers().

Running Plumber APIs

Plumber APIs can be run programmatically
from within an R session.

Path to API definition
library (plumber) e

plumb ("plumber.R") 3>%
6767 Specify API
= 5762
pr_run(port 162) t i

This runs the API on the host machine supported by the current R
session.
IDE INTEGRATION
o Tl &
| @ RSaipt
ok ‘el
r)

Create new
Plumber API

U SifPHeb App... by uior Example API
Documentation

Plumber APIs automatically generate an O
This specification file can be interpreted to
user-interface for the API. The default i
Swagger.

Endpoint details




MEREN
Programmatic Plumber

Tidy Plumber

Plumber is exceptionally customizable. In addition to using special
comments to create APIs, APls can be created entirely programatically.
This exposes additional features and functionality. Plumber has a

convenient “tidy" interface that allows API routers to be built piece by
piece. The following example is part of a standard plumber . R file.

library (plumber) Use @plumber tag

Function that accepts and

function (pr) |

pr %>% modifies a plumber router
pr_get (path = " /echo",
handler = function(msg = "") |(
list (msg = paste0(
“Tidy” functions A LB O T
for building out mi,;?,'
Plumber AP ) )
}) ¥>%
pr_get (path = "/plot",
handler = function() |
rand <- rnorm(100)

hist (rand)
)
serializer = serializer png())
pr_post (path = "/sum",
handler = function(a, b) {
as.numeric(a) + as.numeric(b)

1)

>%

)

OpenAPI

Plumber automatically creates an OpenAPI specification file based on
Plumber comments. This file can be further modified using
pr_set_api_spec() with either a function that modifies the

existing specification ora pathtoa . yaml or . json specification file.

library (plumber)

#? @param msg The message to echo
#+ Bget secho
~ function(msg = "") |

{8 msg, UAIS) I

|

Function that receives
and modifies the existing

specification

FRRRESNORNRNNRN RN R R R A0

Advanced Plumber

REQUEST and RESPONSE

Plumber provides access to special req and res objects that can
be passed to Plumber functions. These objects provide access to the
request submitted by the client and the response that will be sent to
the client. Each object has several components, the most helpful of
which are outlined below:

ASYNC PLUMBER g
plumber supports asynchronous execution via
the future R package. This pattern allows
Plumber to concurrently process multiple
requests.

library (plumber)
future::plan("multisessi n")

Description Set the execution
plan

Name Example

function() |
promises::future_promise ( {
slow_calc()

req

The Plumber router

processing the request L))
1)

Slow calculation

req$pr plumber::pr()

Typically the same as

o b argeBody MOUNTING ROUTE
The parsed body ‘ Plumber routers c:
req$argsBody list(a=1) output routers. Thi

The values of the path

Listices) arguments

req$argsPath

The parsed output from library (plumber)

list(e=5) req$QUERY_STRING

reg$argsQuery

route <- pr() $%>%
pr_get ("/foo", function() "foo")

wan

list(cook = "a") A list of cookies

reqScookies

#* Oplumber

function (pr) |

pr % -
pr_mount ("/bar", route)

The method used for
the HTTP request

req$REQUEST _METHOD e

The path of the

/ incoming HTTP request

req$PATH_INFO
All of the HTTP headers

sent with the request

The raw( ) contents of
the request body

"HTTP_USER_AGENT"

charToRaw("a=1")

HTTP headers to
includein the

list(header =
"abc")



Use Python with R with reticulate

The reticulate package lets you use Python and R together seamlessly in R code, in R Markdown documents, and in the RStudio IDE.

CHEAT SHEET

Pythonin R Markdown

(Optional) Build Python env to use.

Add knitr::knit_engines$set(python =
reticulate::eng_python) to the setup
chunk to set up the reticulate Python
engine (not required for knitr >=1.18).
Suggest the Python environment -
to use, in your setup chunk.

Begin Python chunks with " °

work as expected.

Use the py object to access objects created

in Python chunks from R chunks.

Python chunks all execute within a

single Python session so you have access

to all objects created in previous chunks.

Use the r object to access objects created

in R chunks from Python chunks.

“{python}.
Chunk options like echo, include, etc. all

2 python.Rmd
s X @ Knit -

*“{r setup, include = FALSE}
2 library(reticulate)
........ 3.;virtualenv_create("fmri-proj")
4 ipy_install("seaborn", envname =
5 use_virtualenv("fmri-proj")

" {python}
mport mutplotl\b os mpl

Output displays below chunk, -
including matplotlib plots.

- ‘@ nsen -

“fmri-proj")

=

*Run -

»

© | python.r «

S Vo NOWUV & WNKH

[y

=05
[JSourceonSave = Q / -/ | -+ 5% i Source -
library(reticulate)
py_install("seaborn")

use_virtualenv("r-reticulate")

sns <- import(“seaborn")

dlm(fmrt)

# creates tips
source-python("pxthon.py")
dim(tips) e

# creates tips in main"'-.... !
py_r'un_ftle( "python.py")
dun(pyStlps)

PythoninR

Call Python from R code in three ways

IMPORT PYTHON MODULES

- Use import() to import any n
. Access the attributes of a module with $

+ import(module, as = NULL, cc
TRUE, delay load = FALSE) I pos
convert:




Pyt h O nin th e | D E Requires reticulate plus RStudio v1.2+. Some features require v1.4+.

Syntax Tab completion for Python  Source  Execute Python View Python View Python
highlighting for  functions and objects (and  Python  code line by line objects in the objects in the
Python scripts ~ Python modulesimported  scripts.  withCmd + Enter  Environment Data Viewer.
and chunks. in R scripts). (Ctrl + Enter). Pane.
DT Q“"-. &<~ » L{‘._}blvlc,’hm(non « Addins « B cheat_sheets ~
(.2 ‘python.":gv~ % :\D Envlronmenl_._.»"'i;lswry Co_pne'fl.innr Tutorial ™)
| Q /- S ol e @ | S impon - | V423 MiB Ust - | (-
1 import pandas as pd % Python”~ | E1 MaipModule -
2 import matplotlib as mpl Dot
3 import seaborn as sns 2
4 P [R interface object]
5 tips = sns.load_dataset("tips") || el O tips Dat_pframe: [244 rows x 7 co.
6 print(tips.iloc[0:5]) @ Values -
7 # cache= | mpl
8 sns.set(Q) # data_home= pd
9 sns.lmplot(x="total_bill', y="tip', ey
10 hue="smoker', data=tips)
11 mpl.pyplot.show() XS
11:1 Python =
Console Terminal =  Jobs = =) Files Plots Packages M:Ig Viewer =)
@ Python 3.6.13 - ~/Desktop/cheat_sheets/ & - 1S

> reticulate::repl_python()

Python 3.6.13 (/Users/rstudiointern/Library/r-minicon
da/envs/r-reticulate/bin/python)

Reticulate 1.20 REPL -- A Python interpreter in R.
>>> import pandas as pd

>>> import matplotlib as mpl

>>> import seaborn as sns

Python REPL opens in the console when you

keyboard shortcut.

matplotlib plots
display in plots pane.

2 Zoom \\Eixpon:-'.,. o |4 b0

Press F1 over a Python
symbol to display the help
topic for that symbol..

Configure Python

Reticulate binds to a local instance of Python when you first call import() directly
or implicitly from an R session. To control the process, find or build your desired
Python instance. Then suggest your instance to reticulate. Restart R to unbind.

Find Python

install_python(version, list = FALSE, force =
FALSE) Download and install Python.
install_python("3.6.13")

py_available(initialize = FALSE) Check if
Python is available on your system. Also
py_module_available() an
py_numpy_module(). py_available()

py_discover_config() Return all detected
versions of Python. Use py_config() to check
which version has been loaded. py_config()

virtualenv_list() List all available
virtualenvs. Also virtualenv_root().
virtualenv_list()

conda_list(conda = "auto") List all aval
conda envs. Also conda_binary() and
conda_version(). conda_list)

Suggest an en

Set a default
interpreter in ,
RStudio IDE Global or
Project Options. )




Deep Learning with Keras : : CHEAT SHEET

Intro INSTALLATION
Keras is a high-level neural networks API 2D LoD Evauss Prdicy $he £ r'a:t:lﬁ‘l:lt‘:ge v
developed with a focus on enabling fast * Model : Batch size o ca.n Wates di gLt
experimentation. It supports multiple back- * Sequential * Optimiser * Epochs _’ * Evaluate _’ + classes https://keras.rstudio.com/
ends, including TensorFlow, CNTK and Theano. model * Loss + Validation * Plot * probability Library (keras)

* Multi-GPU + Metrics split install_keras()
TensorFlow is a lower level mathematical model = —
library for building deep neural network % i
architectures. The keras R package makes it https://keras.rstudio.com The “Hello, World! ::\I:r'grs\tr:ﬁ:h
easy to use Keras and TensorFlow in R. https://www.manning.com/books/deep-learning-with-r of deep learning
Working with keras models
DEFINE A MODEL PREDICT CORE LAYERS n
keras_model() Keras Model predict() Generate predictions from a Keras model =' ' e

B layer_input() Input layer

keras_model_sequential() Keras Model composed of

alinear stack of layers predict_proba() a'r!d predict_classes.(_) e - i Ve
Generates probability or class probability predictions l: ] C'Vnt"m::’r:'(‘ \ erato ::S:u -

multi_gpu_model() Replicates a model on different for the input samples L} 0 3y tp

GPUs
gredict_on_batch() Returns predictions for a single
atch of samples

predict_generator() Generates predictions for the
input samples from a data generator



1NN

More layers Preprocessing
CONVOLUTIONAL LAYERS ACTIVATION LAYERS 4 K T Fl
eras ensorFlo
L L layer_conv_1d() 1D, e.g layer_activation(obj ivati 1
i 2 , €.8. 2 ject, activation) pad_sequences()
‘ —ll temporal convolution li Apply an activation function to an output Pads each sequence to the same length (length of P re't rain ed mOd els
the longest sequence) s > -
\ < layer_activation_leaky_relu() r:rta:fepp:%aet?‘:‘:i‘gﬁéﬂ ]
layer_conv_2d_transpose() p— Leaky version of a rectified linear unit skipgrams() bl hts r-"-'h odels can
|ME™ e Transposed 2D (deconvolution) Generates skipgram word pairs VL] 'ct" fesetm'e SN
].I.] ’H_ |ar layer_activation_parametric_relu() PrECiCHRIAISS
—_— layer_conv_2d() 2D, e.g. spatial —  Pparametric rectified linear unit make_sampling_table() application_xception()
convolution over images Generates word rank-based probabilistic sampling xception preprocess_input()
| iV layer_activation_thresholded_relu() table Xception vimodel
——  Thresholded rectified linear unit
1 ol _ layer_conv_3d_transpose() [ 2 S ‘.
L L] : ) - : Transposed 3D (deconvolution) | J layer_activation_elu() A Al .appllc.atlon_mceptlon_ﬂ() t)
layer_conv_3d() 3D, e.g. spatial " Exponential linear unit keni eyt ility mcept‘lon_v:l_prep ) ss_i 0
T e i text_tokenizer() Text tokenization utility lncleptlon &,3tm°de|, with we
. e on ImageNe!
sayerTcomvilstmi2d() :i;ézﬁ_é:;kemzer() Update tokenizer internal
Convolutional LSTM DROPOUT LAYERS application_inception_
Doptree separable2d | layer.dropout) e eatormaie T T lincspacn e
"'qI Depthwise separable 2D ‘=M Applies dropout to the input trained on Ima,
LIERNT - texts_to ces();
5 g layer_upsampling 1d( tayer_spatial_dropout_1d() T e e
layer_upsampling_3d() ;E\Ei ::;::—:::::::—::::g::-gg}; Transforms each text in texts to sequence of integers
u ing — 22 T AT
i psampling layer L] Spatial 1D to 3D version of dropout texts_to_matrix(); sequences_to_matrix()
; = ‘r‘! layer_zero_padding_1d() Convert a list of sequences into a matrix
"lg!ﬂéﬁ layer_zero_padding_2d() N
layer_zero_padding_3d() RECURRENT LAYERS text_one_hot() One-hot encode text to word ind?ifes
Zero-padding layer R
— A @ layer_simple_rnn() text_hashing_trick() .
lll N!.=j layer_cropping_1d() I:l H Fully-connected RNN where the output Converts a text to a sequence of ind
L] layer_cropping_2d() M isto be fed back toinput size hashing space ‘
layer_crorpin;_ad() ) :
Cropping layer text_to_word_sequence(
HAS \y Gated recurrent unit - Cho et al Converttextt uen@!' v
layer_cudnn

_gru()
Fast GRU implementation backed
N Ly or 2



Data Science in Spark with sparklyr ::

Intro

sparklyris an R interface for Apache Spark™.

It enables us to write all of our analysis code in R,
but have the actual processing happen inside
Spark clusters. Easily manipulate and model
large-scale using R and Spark via sparklyr.

Import

rﬁsﬁ\

4 Compute; 24

b 4 _ 4 @

R (k) gy
Collect : Source
Results

Import data into Spark, not R

READ A FILE INTO SPARK

Arguments that apply to all functions:
sc, name, path, options=list(), repartition=0,
memory=TRUE, overwrite=TRUE

spark_read_csv( header = TRUE,
: NULL, Inlgr_schmamzug\

- From R (copy_to())
. Read afile (spark_read_)
. Read Hive table (tb1())

Wrangle
. dplyrverb
+ tidyr commands
. Feature transformer (ft_)
. Direct Spark SQL (DBI)

Visualize
Import . Collect result, plotin R

Model
. Spark MLIib (m1_)

Collect results into
share using R

+ H20 Extension

UiEZE

Translates into Spark SQL statements
copy_to(sc, mtcars) %>%

ft_idf() - Compute the Inverse Document

)E Frequency (IDF) given a collection of
documents.
-

DPLYR VERBS

mutate(trm = ifelse(am == @,
“auto”, "man")) %>%

group_by(trm) %>%

summarise_all(mean)

ft_imputer() - Imputation estimator for
completing missing values, uses the mean
or the median of the columns. 4

=]

ann
x]B12]
[Y]Al3]
Lyigla)

1Al8]

(X11]2]

1314]

LY
» l nest() / unnest() - Convert groups of cells
MY into list-columns, and vice versa.
{alp i .

ft_index_to_string() - Index labels
label as strings

TIDYR

1 B

pivot_longer() - Collapse
several columns into two.

pivot_wider() - Expand two
columns into several.
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' Data Science in Spark with sparklyr : : CHEAT SHEET

RN A-

Modeling

REGRESSION
ml_linear_regression() - Linear regression.

ml_aft_survival_regression() - Paramelric
survival regression model named accelerated
failure time (AFT) model

ml_generalized_linear_regression() - GLM

ml_isotonic_regression() - Currently
implemented using parallelized pool adjacent
violators algorithm. Only univariate (single
feature) algorithm supported

ml_random_forest_regressor() - Regression using
random forests.

~ CLASSIFICATION

ml_linear_svc() - Classification using linear
support vector machines
ml_logistic_regression() - Logistic regression
ml_multilayer_perceptron_classifier() -
Classification model based on the Multilayer
Perceptron.
aive_bayes() - It supports Multinomial NB

can handle finitely supported discrete data

CLUSTERING

ml_bisecting_kmeans() - A bisecting k-means
algorithm based on the paper

ml_lda() | ml_describe_topics() | ml_log_likelihood()
| ml_log_perplexity() | ml_topics_matrix() - LDA topic
model designed for text documents.
ml_gaussian_mixture() - Expectation maximization
for multivariate Gaussian Mixture Models (GMMs)
ml_kmeans() | ml_compute_cost()
|ml_compute_silhouette_measure() - Clustering with
support for k-means

ml_power_iteration() - For clustering vertices of a
graph given pairwise similarities as edge properties.

FEATURE

ml_chisquare_test(x,features,label) - Pearson’s
independence test for every feature against the label

ml_default_stop_words() - Loads the default stop
words for the given language

STATSTS
ml_summary() - Extracts a metric from the summary
object of a Spark ML model
ml_corr() - Compute correlation matrix

R M| N

e

Sessions
B o

ml_call_constructor() - Identifies the associated

sparklyr ML constructor for the JVM 2. Locate path to the cluster

normally is “/usr/lib/:
ml_model_data() - Extracts data associated with a VK by

Spark ML model

ml_standardize_formula() - Generates a formula
string from user inputs, to be used in * ml_model®
constructor

ml_uid() - Extracts the UID of an ML object.

ML Pipelines
Easily create a formal Spark Pipeline models using R.
Save the Pipeline in native Sacala. The saved model will
have no dependencies on R.

INITIALIZE AND TRAIN
ml_pipeline() - Initializes a new Spark Pipeli
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Factors with forcats : : CHEAT SHEET

The forcats package provides tools for working with factors, which are R's data structure for categorical data.

.

¥

Fa CtO s stored displayed
R represents categorical int 1:=-8 [F]1-H
data with factors. Afactor  yector — 3 2= 11 gfg
is an integer vector with a 2 = b -
levels attribute that stores  (evels — 1 =

a set of mappings between
integers and categorical values. When you view a factor, R
displays not the integers, but the levels associated with them.

Create a factor with factor()

a) [E] 1=E1 factor(x = character(), levels,

s 2=[1 |abels = levels, exclude = NA, ordered

b b 3= =is.ordered(x), nmax = NA) Convert

3] 3] a vector to a factor. Also as_factor().
f < factor(c("a"’ ":ll’ Ilb"’ llall)’

levels = c(lla", "bll, Ilc"))

B -8 Bl Return its levels with levels()

g: —> levels(x) Return/set the levels of a

b} factor. levels(f); levels(f) <- c("x","y""2")

Ed Use unclass() to see its structure

Inspect Factors

=] 1= fct_count(f, sort = FALSE,
B , Ha2 prop = FALSE) Count the
= number of values with each

level. fct_count(f)

mumﬂMﬂmwmr
Wvisinf. fct_match(f, "a)

Change the order of levels

B -8 B 1-8
45 > B8
b (b
El E
{ 1= q -3
2= s z=D
El El

1= 1=01
gzﬂ!’ — %2=E|
Bia @ik
m3=_’ma=a
| C ]
H:1-8 H:1=8)
DR S5 i)
] [C]

o)
WN -
o

[o]=)

oo

fct_relevell(f, ..., after=0L)
Manually reorder factor levels.
fct_relevel(f, c("b", "c’, "a"))

fct_infreq(f, ordered = NA)
Reorder levels by the frequency
in which they appear in the
data (highest frequency first).
Also fct_inseq().

f3 <- fICtOI'(C("C", "C", nau))
fct_infreq(f3)

fct_inorder(f, ordered = NA)
Reorder levels by order in which
they appear in the data.
fct_inorder(f2)

fct_rev(f) Reverse level order.
4 <- factor(c("a","b","c"))
fct_rev(f4)

fct_shift(f) Shift levels to left or

right, nd end.
e
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fct_recode(.f, ...) Manually ch
levels. Also fct_relabel() !
purrr:map syntax to app|
or expression to each leve
fct_recode(f, v
fet_relabel(f, ~ past

fet_anon(f,
Anonymize lev
i B




